Abstract


April 2019
Version 1.1

New Jersey Office of Information Technology
Office of Geographic Information Systems
njgin@oit.nj.gov
Contents

About NJGIN Core ............................................................................................................................................. 3
Directions ......................................................................................................................................................... 4
Required Elements ........................................................................................................................................ 4
Optional Elements ......................................................................................................................................... 6
Appendix: Detailed Help ................................................................................................................................ 7
Version History ................................................................................................................................................ 11
NJGIN Core:
Simple Documentation with the ArcGIS Online Metadata Editor (FGDC – CSDGM Style)

About NJGIN Core

https://njgin.state.nj.us/oit/gis/NJ_NJGINExplorer/docs/MD_NJGIN_core_AGOL.pdf

The New Jersey Geographic Information Network (NJGIN) was founded by the NJ Office of Information Technology, Office of Geographic Information Systems (NJOGIS) in 2001 to facilitate the sharing of geospatial content in the NJ GIS community. The focal point of the network is the website, https://njgin.nj.gov, where information consumers can search for geospatial content and data stewards can share their authoritative geospatial content. The search function will transition to Esri’s ArcGIS Online and Open Data platform, including links to records on partner sites.

An essential part of sharing data sets is for data stewards to provide adequate documentation for each item to support discovery and sharing. In order to assist partner data stewards, NJOGIS is releasing the “NJGIN Core” as an abbreviated collection of elements in the ArcGIS Online (AGOL) Editor, set to Style FGDC – CSDGM (https://doc.arcgis.com/en/arcgis-online/manage-data/metadata.htm). These elements together answer the following questions:

- Does a data set exist on a particular topic?
- Does it exist for a particular location?
- What is the temporal context of the data set?
- Who can I contact to learn more about the data set?
- Is it possible to access the data set now?

Below is a list of the essential elements, described in further detail in the later sections of this document.

- Title
- Publication Date
- Description (Abstract)
- Summary (Purpose)
- Credits
- Status
- Keywords & Tags
- Location (geographic extent)
- Time Period of Content (temporal extent)
- Use Limitations
- Metadata date & language
- Point of Contact
Directions

✧ Use Google Chrome browser for best interface.
✧ Only parts of Resource and Metadata sections are included in the required elements list. It is perfectly acceptable to use additional fields. Don’t forget to update them when the Item changes.
✧ L1, L2, L3 and L4 refer to the level of nested pages and tabs in the editor (see image below):

The required elements list ends on page 5, and optional elements list is on page 6. The balance of this document provides help information in more detail: listed elements have hyperlinks to the help.
✧ Text below in bold shows AGOL Metadata Editor labels. Stars ☆ indicate data entry points. [Brackets] contain brief help information.

Required Elements

✧ Resource tab L1
  Citation tab L2 > Titles & Dates tab L3
  ☆ Title
  ☆ Publication Date [Remember to update when any change is made to data]
  Citation tab L2 > Contact tab L3 [repeatable] > First Contact > Contact Name tab L4
  ☆ Organization Name and/or Individual Name
  ☆ Role [= Originator]
  Second Contact for Publisher.
  Skip for now [editor bug]

Details tab L2 > Description tab L3
  ☆ Description (Abstract)
  ☆ Summary (Purpose)
  ☆ Credits [Include all organizations to show on Item page]

Details tab L2 > Status tab L3
  ☆ Status

Keywords tab L2 > specific types of keywords L3
  ☆ Topic Category [ISO Theme Keyword. Check on one, or two; definitions are listed in online document MD_AGOL_Item_help.pdf.]
Theme Keywords [slide on if using]
Keywords
Place Keywords [slide on]
Keywords [Enter at least a fully qualified description of coverage area, e.g. Trenton, Mercer County, New Jersey]
Tags [Copy in all keywords]

Extent tab L2 > Resource Extent first instance [repeatable] > Geographic tab L3
Geographic Extent [slide on] > Bounding Box tab L4
Extent is for search
Extent contains the resource
THEN
Set Geographic Extent you can draw extent on map
OR, enter:
Four Bounding Coordinates [signed decimal degrees]

Extent tab L2 > Resource Extent: create second instance [Add by using + button; fill out for data with known collection dates]
Temporal tab L3
Temporal Extent (Time Period of Content)
Time Period tab L4
Begin Date
End Date
OR Time Instant tab L4
Date

Description tab L3 [for Temporal Extent]
Temporal Extent Description [Currentness Reference: enter Ground condition, or other description of how the dates relate to the data.]

Constraints tab L2 > Resource Constraints [slide on] > General tab L3
Use Limitation [Use Constraints and legalese for Distribution Liability.]

Distribution tab L1 [Fill out only if the data are available outside of ArcGIS Online/ Open Data, and/or if there is a charge for the data. Details below in Optional section.]

Metadata tab L1
Profile tab L2 [Displays the ArcGIS Metadata Style as set at the AGOL Site level.]
Scope tab L2
Metadata Date [Will fill in automatically, can be changed.]
File Identifier [Will fill in automatically; see help for details.]

Language tab L2
Metadata Language [Pick from list]

Contact tab L2 > Metadata Contact > Contact Name tab L3
Individual Name
Organization Name
Role [=Point of Contact]

Contact tab L2 > Metadata Contact > Contact Information tab L3
Enter full contact address information (all fields)
Enter Voice on Phone tab [Metadata Contact Voice Telephone: Include area code]
Optional Elements

✦ For content that allows AGOL Editor validator to run without error, add the following:

✦ **Resource** tab L1
  ✦ **Extent** tab L2
    ✦ for second instance of Resource Extent for Temporal Extent, even if the description is Publication Date. See above for Editor details.

✦ **Maintenance** tab L2
  ✦ **Frequency** tab L3
    ✦ Update Frequency
    ✦ OR
    ✦ Custom Frequency

✦ If the data are available outside of ArcGIS Online, and/or if there is a charge for the data, add the following:

✦ **Distribution** tab L1
  ✦ **Distribution Information** [Slide on if not on already]

✦ **Distributor** tab L2 [repeatable]
  ✦ Distributor [slide on]

✦ **Transfer Options** tab L3
  ✦ Digital Transfer Options [Slide on]

✦ **Online Resource** tab L4
  ✦ Online Resource [slide on]
  ✦ **URL** [For primary distribution method outside of AGOL/Open Data]

  AND
  ✦ **Function** [Pick from list]

✦ **Format** tab L3
  ✦ **Distribution Format** [Slide on]
  ✦ **Format Name** [Use a well-known entry if possible]
  ✦ **Format Version** [number or date]
  ✦ **Specification** [URL to format spec]
  ✦ **Information Content** [Explanation of the service type or file type in words]
  ✦ **Decompression Technique** [only if applicable]

✦ **Contact** tab L3 (slide on)
  ✦ **Contact Name** tab L4
    ✦ **Organization Name**
    ✦ **Role**=Distributor

  **Contact Information** tab L4 see list and help for Metadata Contact.

✦ **Ordering Process** tab L3
  ✦ **Fees**
  ✦ **Monetary units**
  ✦ **Ordering Instructions**
## Appendix: Detailed Help

<table>
<thead>
<tr>
<th>ArcGIS field and (CSDGM element)</th>
<th>Required</th>
<th>AGOL Editor location</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Title**                        | Y        | Resource > Citation > Titles & Dates > Title | This will show up in search results. Include enough information to distinguish from other entries. *Alternate Title* field can be used for a well-known abbreviation or file name. Here is an example of a good *Title*: *Congressional District Boundaries for the State of New Jersey, 2012 - 2022; unofficial, nj_munis - based*
|                                  |          |                      |       |
| **Publication Date**             | Y        | Resource > Citation > Titles & Dates > Publication Date | This date is required. *Change the Publication Date of the item every time there is a discrete update.*
|                                  |          |                      |       |
| **Online Resource URL**          | Opt      | Resource > Citation > URLs > Online Resource > URL | Add URL to more information about the data and / or your organization. Field is repeatable.
<p>| <strong>Resource Contact Originator</strong>  | Y editor bug - can be entered, but metadata stylesheet does not display it. | Resource &gt; Citation &gt; Contact &gt; Citation Contact &gt; Contact Name &gt; Organization Name AND Role = Originator | Party responsible for defining the data set. A fully-qualified name should be used, starting with the main organizational unit and specifying down the hierarchy, followed by any well-known abbreviation. Example: NJ Department of Environmental Protection, Division of Information Technology, Bureau of Geographic Information Systems (NJDEP - DOIT - BGIS). |
| <strong>Resource Contact Publisher</strong>   | Editor bug - can’t be filled in. Include if they fix it. | Resource &gt; Citation &gt; Contact &gt; Citation Contact &gt; Contact Name &gt; Organization Name AND Role = Publisher | Use same format as for Originator. Put in Credits if different from Originator |</p>
<table>
<thead>
<tr>
<th>ArcGIS field and (CSDGM element)</th>
<th>Required</th>
<th>AGOL Editor location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description (Abstract)</td>
<td>Y</td>
<td>Resource &gt; Details &gt; Description &gt; Description (Abstract)</td>
<td>Should be understandable to intelligent general reader, and convey the subject of the data set. Include the data set format; and coordinate system, datum, units if you can.</td>
</tr>
<tr>
<td>Summary (Purpose)</td>
<td>Y</td>
<td>Resource &gt; Details &gt; Description &gt; Summary (Purpose)</td>
<td>Business reason why the data were created, and/or anticipated suitable uses for the data.</td>
</tr>
<tr>
<td>Credits</td>
<td>Y</td>
<td>Resource &gt; Details &gt; Description &gt; Credits</td>
<td>Include (copy in) the Originator, add the Publisher if different, and add any other contributors of funding or work.</td>
</tr>
<tr>
<td>Status (Progress)</td>
<td>Y</td>
<td>Resource &gt; Details &gt; Status &gt; Status</td>
<td><strong>Complete</strong> if data set covers all the intended area &amp; time, even if updates are ongoing; <strong>In Work</strong> if published as a partially-completed release; <strong>Planned</strong> if contemplated, or in-progress but not published yet.</td>
</tr>
<tr>
<td>Topic Category (ISO Theme Keyword)</td>
<td>Y</td>
<td>Resource &gt; Keywords &gt; Topic &gt; Topic Category</td>
<td>Check on one, or if necessary, two. Definitions are provided <a href="#">MD_AGOL_Item_help.pdf</a>, Section I.</td>
</tr>
<tr>
<td>Tags</td>
<td>Y</td>
<td></td>
<td>Will contain any tags entered when creating the item. Copy in all other keywords you have added.</td>
</tr>
<tr>
<td>Theme Keywords</td>
<td>Opt</td>
<td></td>
<td>List other subject keywords or phrases that others might use to search for the data. Separate with newline.</td>
</tr>
<tr>
<td>Place Keyword</td>
<td>Y</td>
<td>Resource &gt; Keywords &gt; Place &gt; Place Keywords &gt; Keywords</td>
<td>List keywords or phrases that might be used to search for the data. The first word or phrase should fully specify the geographic location: e.g., Trenton, Mercer County, New Jersey.</td>
</tr>
<tr>
<td>ArcGIS field and (CSDGM element)</td>
<td>Required</td>
<td>AGOL Editor location</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bounding Box (Bounding Coordinates) (4)</td>
<td>Y</td>
<td>Resource &gt; Extent &gt; Resource Extent &gt; Geographic &gt; Geographic Extent &gt; Bounding Box</td>
<td>Check ON Extent is for search? AND Extent contains the resource? Each of four geographic coordinates is in signed decimal degrees; sign included only for negative. The AGOL editor Set Geographic Extent function captures coordinates from a box drawn on a map.</td>
</tr>
<tr>
<td>Temporal Extent (Time Period of Content) Date(s)</td>
<td>Y, only required if different from Publication Date</td>
<td>Resource &gt; Extent &gt; Resource Extent (2) &gt; Temporal &gt; Temporal Extent &gt; Time Period &gt; Begin Date AND End Date, OR Time Instant &gt; Date</td>
<td>Do not add this information to the same resource extent that describes the Geographic Extent (Bounding Box.) Create a new Extent section. For example, if the data were captured by a sensor in July, but not processed and published until September, a Temporal Extent should be used to specify the capture date(s.) If you need to express a range, use Time Period &gt; Begin Date and &gt; End Date. If you need to express multiple specific dates, use multiple instances of Temporal Extent, Time Instant Date. Optional for minimal metadata if the data content date would be described as publication date. Required by AGOL validator.</td>
</tr>
<tr>
<td>Temporal Extent Description (Time Period of Content Currentness Reference)</td>
<td>Y, only required if different from Publication Date</td>
<td>Resource &gt; Extent &gt; Resource Extent (2) &gt; Description &gt; Extent Description</td>
<td>Fill this in for the same Resource Extent as the Temporal date(s.) Enter Ground Condition or another phrase, explaining how the time period of content relates to the data. If you know when the data matched the real world, use Ground Condition. Required by AGOL validator.</td>
</tr>
<tr>
<td>Update Frequency (Maintenance and Update Frequency)</td>
<td>Opt</td>
<td>Resource &gt; Maintenance &gt; Resource Maintenance &gt; Frequency &gt; Update Frequency</td>
<td>Please use As Needed only if there is a structured routine in place for change detection and update. Otherwise one of, Irregular, Unknown, or Not Planned is more appropriate. Required by AGOL validator.</td>
</tr>
<tr>
<td>Use Limitation (Use Constraints)</td>
<td>Y</td>
<td>Resource &gt; Constraints &gt; Resource Constraints &gt; General &gt; Use Limitation</td>
<td>Enter limitations on use, requests or requirements for attribution, and any legal disclaimer required by your organization. For public data, suggested language that does not conflict with the NJ Open Public Records Act is in MD_AGOL_Item_help.pdf, Section II.</td>
</tr>
<tr>
<td>ArcGIS field and (CSDGM element)</td>
<td>Required</td>
<td>AGOL Editor location</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------</td>
<td>----------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Distribution (Distribution Information)</td>
<td>Opt. If used, all listed under Distribution should be used.</td>
<td>Distribution &gt; ...</td>
<td>Needed only for Items distributed outside of ArcGIS Online/Open Data.</td>
</tr>
<tr>
<td>URL</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Transfer Options &gt; Online Resource &gt; URL</td>
<td>Preferably, an actionable internet address for the resource, such as a direct download or REST service endpoint.</td>
</tr>
<tr>
<td>Function</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Transfer Options &gt; Online Resource &gt; Function</td>
<td>For downloadable data, catalog access, etc; leave empty if nothing matches, e.g for live services.</td>
</tr>
<tr>
<td>Format Name</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Format &gt; Format Name</td>
<td>e.g. Esri map service – ArcREST; Shapefile; WMS; File geodatabase; Cached map tiles; Streamed features; etc.</td>
</tr>
<tr>
<td>Format Version</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Format &gt; Format Version</td>
<td>Enter a software version number or a date. If using a date, format as follows: 2019-04-08.</td>
</tr>
<tr>
<td>Information Content</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Format &gt; Information Content</td>
<td>Verbal description of information delivered by the format. E.g. for shapefile: Nontopological geometry and attribute information for the spatial features in a data set.</td>
</tr>
<tr>
<td>Decompression Technique</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Format &gt; Decompression Technique</td>
<td>Name and specification for compression, only if applicable. E.g. for zip: ZIP; <a href="https://pkware.cachefly.net/webdocs/casestudies/APPNOTE.TXT">https://pkware.cachefly.net/webdocs/casestudies/APPNOTE.TXT</a></td>
</tr>
<tr>
<td>Distributor Contact</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Contact &gt; ...</td>
<td>Except for role, same instructions as for filling in Metadata Contact, except that an individual name rarely is appropriate. Organization and Contact Information may be different from the Metadata Contact.</td>
</tr>
<tr>
<td>Fees</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Ordering Process &gt; Fees</td>
<td>If no charge, enter 0.00.</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Ordering Process &gt; Monetary Units</td>
<td>Select correct units from list, e.g. “US Dollar.” Required even if Fee is 0.00.</td>
</tr>
<tr>
<td>----------------</td>
<td>-----</td>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ordering Instructions</td>
<td>Opt</td>
<td>Distribution &gt; Distributor &gt; Ordering Process &gt; Ordering Instructions</td>
<td>Verbal description of how to obtain access to the data or service.</td>
</tr>
<tr>
<td>Metadata Date</td>
<td>Y</td>
<td>Metadata &gt; Scope &gt; Metadata Date</td>
<td>Should autopopulate. Change the date whenever the metadata are changed.</td>
</tr>
<tr>
<td>File Identifier</td>
<td>Opt</td>
<td>Metadata &gt; Scope &gt; File Identifier</td>
<td>Automatic entry. If metadata are downloaded for re-use, delete the entry in the copy; located at /metadata/mdFileID</td>
</tr>
<tr>
<td>Metadata Language</td>
<td>Y</td>
<td>Metadata &gt; Language &gt; Metadata Language</td>
<td>Pick from list.</td>
</tr>
<tr>
<td>Metadata Contact Individual Name (Person)</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Name &gt; Individual Name</td>
<td>Should be the name of someone who can answer questions about the metadata and the Item.</td>
</tr>
<tr>
<td>Metadata Contact Organization Name</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Name &gt; Organization Name AND Role = Point of Contact</td>
<td>Structure this the same way as Originator (see above), although it may very well be a different organization.</td>
</tr>
<tr>
<td>Metadata Contact Email (Electronic Mail Address)</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; Email</td>
<td>For NJ State addresses, usually has to be postal OR physical, because the two zip codes are not the same.</td>
</tr>
<tr>
<td>Metadata Contact Address Type</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; Address type</td>
<td>Use only PO Box OR street address in one entry. If both have the same zip code, you can enter the second one in a second instance of Delivery Point.</td>
</tr>
<tr>
<td>Metadata Contact City</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; City</td>
<td>Postal City</td>
</tr>
<tr>
<td>Metadata Contact Administrative Area (State or Province)</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; Administrative Area</td>
<td>Two-letter abbreviation may be used.</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>---</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Metadata Contact Postal Code</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; Postal Code</td>
<td>Zip code</td>
</tr>
<tr>
<td>Metadata Contact Country</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Address &gt; Country</td>
<td>Pick from list.</td>
</tr>
<tr>
<td>Metadata Contact Voice Telephone</td>
<td>Y</td>
<td>Metadata &gt; Contact &gt; Contact Information &gt; Phone &gt; Phone &gt; Voice</td>
<td>Include area code.</td>
</tr>
</tbody>
</table>

**Version History**

Version 1.1: Removed entries that are no longer required by the AGOL validator. Added fuller optional Distribution Information. Other minor editorial changes.